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CD-ROM User’s Guide 

 

I. System requirements 

 A computer with Adobe® Illustrator 10 and Microsoft® Word installed and running 

efficiently is required. A free tryout version of Illustrator 10 can be downloaded from the Adobe 

Website. 

 

II. Overview 

 This CD-ROM contains a variety of Interactive Brain Maps—computer graphics files that 

can be used for many purposes such as learning about the structural organization of the brain, 

mapping experimental results, constructing 3-D models, and creating databases of spatial 

neuroanatomical information. Because the files are based on vector graphics they can be 

modified easily by users, are almost infinitely scalable, and have a relatively small file size. 

 The heart of this material is an Interactive Brain Maps atlas. Atlas Levels 1-73 in section 

VII of the book were derived from these computer graphics files. Two versions of the Interactive 

Brain Maps atlas are provided. One version is complete, and features bilateral maps, a Nissl-

stained section on one side, a list of abbreviations, two sets of coordinates—stereotaxic and 

physical, and a simple yellow mask. Because these features are placed in different transparent 

overlays or layers, they can be viewed in any combination and order desired by users. The other, 

simplified, version is designed for mapping experimental results, and only contains the bilateral 

drawings of the brain, along with an alignment box for databases and 3-D modeling. 

 Layers are an extremely important feature of the Interactive Brain Maps. Layers are 

perfectly aligned transparent overlays, and they can be viewed in any combination and 
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rearranged in any order. This powerful feature allows one to separate information (for example, 

the results of different experiments, or different features of the atlas such as abbreviations, cell 

groups, and fiber tracts) in useful, creative ways, and then view or hide, lock or unlock, and 

delete or add individual layers. As one works with these complex drawings, the value of layers 

becomes increasingly obvious, especially when taking advantage of the ability to move graphical 

elements between layers, and to duplicate information in more than one layer. 

 

IV. Using downloadable Adobe Illustrator® files 

 Microsoft® PowerPoint has introduced most scientists to the potential usefulness of 

computer graphics. However, in this day and age the creation, manipulation, and publication of 

neuroanatomical information requires a working knowledge of more powerful graphics software. 

The downloadable files provided here were created with Adobe® Illustrator 10 and Adobe® 

Photoshop 7. Essentially identical versions of these applications are available for the PC and 

Mac. Adobe® Photoshop is designed primarily to work with bitmapped (rasterized) images such 

as videophotos or scanned images and films, whereas Adobe® Illustrator is designed to create 

vector-based drawings, which may be combined with placed bitmapped art (for example, from 

Photoshop) for the construction of illustrations for PowerPoint presentations, printing, 35 mm 

slides, and publication. There are several other popular computer graphics applications—

including Macromedia® FreeHand 10, Deneba® Canvas 8, and CorelDRAW® 11—and 

Adobe® Illustrator files usually can be opened and worked on in them (contact the manufacturer 

if procedures are not obvious). 

 The Adobe® Illustrator tutorial is an essential and enjoyable prerequisite for those not 

comfortable with the program. 
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 Always work with copies of the files. It is essential to keep at least one copy of the original, 

unaltered files. 

 

A. Tips on making illustrations 

 The general philosophy of using computer graphics applications for producing 

neuroanatomical illustrations is outlined in section IVB3 of the book. The following discussion is 

based on using Adobe® Illustrator 10, although the general principles apply to other popular 

applications. 

 It is necessary at the outset to learn how to use the layers manager or palette. Layers are like 

a perfectly aligned stack of transparent overlays. Their stacking order can be changed at any 

time, they can be viewed in any combination by hiding individual layers, and any combination of 

layers can be chosen to print. One obvious use would be to place the results of a tract tracing 

experiment in a layer over an atlas template, or the results of two tracing experiments in two 

layers over an atlas template (with the results of each experiment in a different color; see files in 

A4). It is important to remember that opaque objects in a layer “block out” or obscure all objects 

in layers below them in the stacking order, just as in a stack of transparent overlays. This must be 

considered when changing the stacking order of layers. It is also useful to know that objects can 

be moved from one layer to another simply by selecting the object (or objects) and moving the 

resulting dot in the layers palette to the desired layer. Similarly, an object(s) in one layer can be 

duplicated (select, copy, paste in front) and then moved to any desired layer, so the same object 

appears in two layers. 

 Drawing in a layer is, of course, a basic operation or skill that is usually the most frustrating 

part of learning a computer graphics application. Like pen and ink drawing, it requires practice, 
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and can always be improved. Curved lines in Illustrator are based on creating Bezier curves, 

which are smooth and mathematically defined (explaining why they are essentially infinitely 

scalable without loss of resolution). 

 

            

 

 To learn how to use the pen tool for drawing, first read the Illustrator User’s Guide. 

Basically, curved lines (paths) are drawn by creating a series of smooth anchor points, each with 

a direction line on either side, and a direction point on the end of each direction line (Figure 1). 

These points and lines are used to edit in a very precise way paths that have already been drawn. 

Several rules help produce the most esthetically pleasing drawings. (1) Use the minimum number 

of anchor points consistent with the desired line. This requires practice, and planning ahead 

while drawing. It is essential that one does not try to draw too fast; think deliberately about what 

you are drawing. It is instructive to see how Illustrator draws a circle. To do this, use the circle 
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tool, and then select it to see the anchor points, direction lines, and direction points. Note only 

four anchor points, and equally spaced direction points. In general, use fewer anchor points on 

less curved regions of a path. (2) Keep facing direction points for adjacent anchor points on the 

same side of a path. And (3), try to follow the “thirds rule”: in the space between two anchor 

points, each direction line, and the distance between the two direction points, should be 

approximately equal (that is, each should be about a third of the distance). This is perfectly 

shown in the way Illustrator draws a circle. 

 Paths can also contain corner anchor points. The path in Figure 1 was drawn with six anchor 

points, four of them smooth (a-d) and two of them corner (e, f). Corner anchor points are created 

by clicking (rather than clicking and dragging) and are used to create angles in a path (use the 

rectangle tool to create a rectangle or square and note that it consists of only four corner anchor 

points). 

 Learn how to use all of the tools in the toolbox palette. They are used for editing paths, as 

well as for scaling, magnifying, rotating, reflecting, and skewing; for placing and modifying text; 

and so on. Also learn how to change line thickness and color, and how to create dashed lines. 

 The pencil tool is useful for drawing irregular lines (such as PHAL-labeled axons), although 

you will note that even these paths are actually Bezier curves that Illustrator creates for you, and 

may thus be edited like paths drawn with the pen tool. Although it takes essentially no practice to 

use the pen tool, it is also not appropriate to use when drawing smooth paths. 

 Symbols (circles, squares, and so on) from the Symbol font are usually best to use for items 

showing the location of labeled neurons and so on. Although they require more memory than 

symbols created with Illustrator paths, they maintain their relative positions when maps are 

rescaled. 
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 For most routine drawing, it is helpful to show two Adobe® Illustrator 10 palettes along the 

top of the Window: one in the upper left with the Layers, Character, and Paragraph subpalettes, 

and the other in the upper right with the Stroke, Color, and Swatches subpalettes. 

 

B. Permission to use the illustrations 

 While these files have broad applications, their use in published figures should acknowledge 

that they are based on Brain Maps: Structure of the Rat Brain, third revised edition (Swanson, 

2004). No other permission is required. [Note added in 2015: This material is now open access 

and simply licensed under a Creative Commons Attribution-NonCommercial 4.0 International 

License; basically, for noncommercial use only, and please cite source of illustration]. 

 

C. Interactive Brain Maps (Adobe® Illustrator 10 files) 

1. Adult rat brain atlas 

 There are three files or sets of files dealing with the Atlas. One file is called Atlas levels 

(sagittal), and it is a midsagittal view of the rat brain showing the location of the 73 Atlas Levels 

(Fig. 10 in the book). The two sets of files contain the individual atlas levels themselves. Brain 

Maps, CGF 3.0/COMPLETE (Brain Maps, Computer Graphics Files 3.0/COMPLETE) is the 

third edition of Brain Maps, Computer Graphics Files (Elsevier, Amsterdam, 1993; included in 

archival material, below) and is a truly interactive atlas, with bilateral maps, accompanying 

photomicrographs of the Nissl-stained sections, a list of abbreviations, two coordinate systems, 

and a simple yellow mask; and Brain Maps, CGF 3.0/Map only, which contains only bilateral 

atlas maps for creating neuroanatomical data overlays. The drawings are all at the same scale, are 

in register, and are designed to fit on a piece of US letter size (8.5 x 11 in.) paper when printed. 
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 Individual atlas levels in Brain Maps, CGF 3.0/COMPLETE are easy to use when opened in 

Adobe® Illustrator 10, with the Layers palette showing and extended to display all nine layers 

(after opening a file, select Fit in Window in the View menu). Simply hide and show different 

combinations of layers. When printing, remember that you have the option to print or not to print 

each layer. It is also simple to move different components of the atlas drawing into different 

layers. This is easy because different components are grouped, and can be selected with the 

selection tool (black arrow, upper left). Create a new layer and move the selection to it. The atlas 

drawing layer has the following groups, which must be stacked in the following order of layers 

(from bottom to top): (1) cell group outlines, (2) fiber tracts (shaded or filled) and on top of them 

fiber tract subdivisions (lines or paths), (3) brain outlines and ventricles, and (4) abbreviations. 

The yellow mask layer just below the atlas layer is useful when one atlas level is placed 

partly over another in a composite illustration because the mask blocks out the part of the bottom 

atlas level that lies directly underneath the top atlas level (Figure 2). The mask is a compound 

path, so that the ventricles are like holes in the tissue section that are not masked. Of course the 

fill color of the mask can be changed to anything desired, including most often white for 

publication. 

 Individual atlas levels in Brain Maps, CGF 3.0/Map only are much simpler; they consist 

only of the atlas layer of Brain Maps, CGF 3.0/COMPLETE (and thus have no mask), as well as 

an alignment box layer. They are very convenient for straightforward mapping of 

neuroanatomical data in a new overlying layer or layers. 

 Cropping part of an atlas level in Brain Maps, CGF 3.0/Map only for a final illustration is 

relatively straightforward. The easiest way to start involves creating a rectangle of the 

appropriate size and location, locking it; and then using the scissors tool to cut lines in the atlas 
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drawing along the border of the rectangle. Then select lines and text outside the rectangle and 

delete. The only problem arises when certain oddly-shaped filled objects (fiber tracts) are cut in 

such a way that the fill pattern is disrupted. When this happens, some redrawing (usually forming 

a closed path at the corner of the locked rectangle) is necessary (Figure 3); this is especially easy 

if the fiber tracts are placed in a separate layer for editing, and then returned to the atlas layer 
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(between cell groups and brain outlines/ventricles groups; the stacking order of selected objects, 

such as fiber tracts, can be altered from the Arrange submenu in the Object menu). 

 

      

 

 Note that all atlas levels in both Brain Maps, CGF 3.0/COMPLETE and Brain Maps, CGF 

3.0/Map only have a layer called box for database/3D model. This layer contains a bounding 

blue rectangle, which is a database fiducial. It has two purposes. First, it is perfectly in register 

along the z-axis of the brain for all 73 Atlas Levels. Taken together, they can be thought of in 

three dimensions as forming the sides of a rectangular box around the brain. And second, the 

blue rectangle should be copied to data layers that are used in neuroanatomical graphical 

databases; it assures perfect alignment of the data layers (in the absence of the atlas layer, for 

example)—hence the name “database fiducial” (see section IVC in the book and section 4b 

below). 

 

2. Flatmaps 
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 The purpose of these design aids is to provide standardized templates for illustrating all 

neural systems in a uniform way (see section V in the book, as well as the frontispiece and 

poster, which were created with the Rat CNS flatmap). Rat CNS flatmap 3.0 is an updated, 

computer graphics version of Figure 7 in the first edition of Brain Maps: Structure of the Rat 

Brain (Elsevier, Amsterdam, 1992), which did not contain pathways. Open this file in Adobe® 

Illustrator 10, show the Layers palette and all of its contents, and then begin near the bottom of 

the Layers palette to show and hide the various layers to see what they contain (general contents 

are indicated by the name in the Layers palette). 

 The Rat CNS flatmap 3.0 file contains most of the major known pathways in the rat, placed 

in a standardized position. This version of pathway placement over the flatmap should be 

considered provisional—as a “work in progress” that will undoubtedly benefit from refinements 

in the future. 

 To create a circuit diagram, view the SIMPLE OUTLINE (for pathways) layer, and hide all 

the others. View a layer containing pathways of interest. Select, copy, and paste in front, then 

move duplicated pathways to a NEW DRAWING layer. Fine tune the ends of pathways with the 

pen tool, show cell groups of interest (e.g., by a circle created with the symbols font), arranging 

the circuit in an aesthetic way (choose appropriate line thicknesses, colors, and so on). Repeat 

this process until you have all of the pathways necessary for the circuit diagram, and refine the 

overall design. Labels are provided in the footprint abbreviations layer. Near the end, copy your 

NEW DRAWING layer(s) and an appropriate outline layer to a new file (lock all other layers and 

select all), where components may be placed in layers as desired, and the diagram can be printed 

from a much smaller file. 
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 The approximate location of atlas sections through the cerebral cortex is shown in relation to 

the Rat CNS flatmap 3.0 in a file called Cortex sections on flatmap (this drawing is 250% larger 

than the flatmap itself), as well as in a layer of the Rat CNS flatmap 3.0 file. The idea here is to 

provide a qualitative way to map the distribution of neuroanatomical data onto a flattened 

representation of the cerebral cortex. Variations in the contour pattern are a reflection of 

curvature on the surface of the intact cerebral cortex. Each line in the contour map is derived 

from the cortical surface of a particular Atlas Level (as indicated). 

 A flatmap of the rat hippocampal formation (Unfolded hippocampal formation) is also 

provided. Its shape is not derived from the Rat CNS flatmap 3.0, but rather from the surface of a 

three-dimensional model of the hippocampal formation (Swanson et al. 1978). The original map 

has been modified in light of more recent data (Petrovich et al. 2001) and understanding. As with 

the above files, different types of information are in different layers. 

 Finally, a simple Human CNS flatmap 1.0 file is provided for comparison with the rat. This 

file was used to produce Figure 2, and the accompanying poster, in Swanson (1995). The major 

feature of interest here is a flatmap of Brodmann’s areas in the cerebral cortex. 

 

3. Determining section angles 

 It is very useful for mapping to have a good estimate of how the plane of section of an 

experimental brain compares with that of the standard atlas plane of section (see Figure 7 in the 

book). The solution presented here is graphical. Assuming that the midline of the experimental 

sections is set to vertical, there are two degrees of freedom: a dorsoventral difference in plane of 

section, and a mediolateral difference in plane of section. The former is seen as a difference in 

the sagittal view, whereas the latter is seen in a dorsal (used here) or ventral view of the brain. 
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The basic principle is to determine how particular pairs of fiducial points differ between the atlas 

and an experimental brain. 

 The two files presented here are designed to determine plane of section for structures located 

in or near the interbrain. For other parts of the brain, the user should determine appropriate 

fiducials (see section IVB2 in the book, and the file Sagittal & dorsal brain views). 

 Interbrain section plane (practical example). This file is a 150% enlargement of the 

interbrain region from the file Sagittal & dorsal brain views (which displays the same fiducial 

points). It contains sagittal and dorsal views of the interbrain region of the atlas brain (which was 

embedded in celloidin, and thus shrank considerably; see section IIIA in the book) with the series 

of Atlas Levels superimposed. It also contains sagittal and dorsal views of a brain prepared by 

frozen sectioning (the atlas brain was scaled to approximate the coordinates in Paxinos and 

Watson, 1986; see section IIIA in the book). 

 The basic principle is to align a regularly spaced Nissl-stained series of sections from the 

experimental brain (frozen sections) on the frozen-sectioned brain outlines here, basing the 

alignment on the position of fiducial points. A series of lines representing the experimental series 

is constructed to scale (using the rulers), and then rotated relative to the standard series, based on 

the position of the fiducials. This is a graphical solution that does not require mathematical 

calculations, although the angles can of course be determined. 

 One practical strategy to determine the plane of the experimental brain is first to determine 

how many sections from the experimental series fit between two widely-spaced fiducials, such as 

the rostral tip of the suprachiasmatic nucleus (SCH) and the caudal end of the mammillary recess 

(V3mr). This number of sections is fitted between the two fiducials (e.g., by moving, rotating, 

and scaling the sample frozen section series provided in the Layers palette) in the drawing of the 
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MIDSAGITTAL VIEW. Second, to determine the “dorsoventral” error in plane of section, observe 

which section in the experimental series passes through a dorsal fiducial (e.g., the caudal anterior 

commissure, ac), and which section passes through a fiducial more or less ventral to the first 

(e.g., the rostral SCH). Rotate the group of experimental sections to reproduce these 

relationships. If necessary, rescale the set of experimental sections so that the correct number of 

sections still stretches between the rostral and caudal fiducials determined in the first step. One 

now sees how the experimental series is oriented relative to the atlas sections. And third, to 

determine the “mediolateral” error in plane of section, repeat the above process using the 

drawing of the DORSAL VIEW, with appropriate fiducials. Obviously, error will be reduced by 

using fiducials that are as far apart as practical (see section IVB in the book). 

 

4. Database prototype 

 A web-based browser for neuroanatomical data mapped onto Brain Maps, CGF 3.0 is under 

development (see Dashti et al. 1997, 2001). The two files in this folder show how data layers 

from this database could be used in the layer manager of Adobe® Illustrator. The basic idea is 

discussed in section IVC of the book. Note that file Sample data layer (Level 19) contains only 

the data itself, and a blue bounding rectangle, the database fiducial, which is found in every atlas 

level (in the layer called box for database/3D model). It can be copied, pasted in front, and 

moved to any other (data) layer. 

 

D. Other downloadable files 

 Several other useful file sets are provided on the CD-ROM. First, lists of abbreviations are 

provided for this edition of Brain Maps, and for our atlas of the developing rat brain. Together, 
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they constitute a systematic, internally consistent nomenclature (with abbreviations) for all stages 

of rat brain development, and the adult brain. 

 And second, three folders are provided in the Archival material section. One folder contains 

the files of Brain Maps, Computer Graphics Files 1.0 (Elsevier, Amsterdam, 1993) which were 

originally supplied on four floppy discs; the second folder contains the original files used to print 

the shaded drawings in Brain Maps: Structure of the Rat Brain (Elsevier, Amsterdam, 1992), and 

the third folder contains the Computer Graphics Files 2.0/Map only files, supplied originally on 

CD-ROM. 

These files must not be confused or mixed with Brain Maps, Computer Graphics Files 

3.0 supplied above. They are provided for historical reasons, so that interested readers can 

compare changes in the atlas from the first to the second to the third edition (for example, a 

considerable amount of data was published using the first two editions as templates). 


